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What’s Responsive?

ANNOUNCING THE ”
MASTER OF SCIENCE

ANNOUNCING THE o
¢ MASTER OF SCIENCE
IN ROBOTICS

Today, you can access websites on a desktop, laptop, tablet, mobile phone and other
devices, each with varying screen sizes. Responsive design is a method of creating a
flexible or fluid website layout that will adapt to any size screen.

The layout of the page changes and items in the page shrink, shift around and collapse
as the viewing screen size decreases. Because the layout transforms for different screen
sizes, it’s important not to refer to things on the page as “to the left,” “above,” “below,”
or “to the right.” The position may change. It’s also very important to follow guidelines
illustrated in this manual for headers, image sizes, etc. to ensure the site looks good and
performs well on different devices.

Take a look at how the basic page transforms as the screen decreases from desktop size
down to mobile:

Desktop Size

Main Content Area
Includes optional header
image/slideshow and body
content

1ol O AL ..

Rig Callout Box
(Optional &
not shown on
— >  this page.
See...)
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Mobile Phone Size

At mobile size, the feature slideshow The main site navigation can be expanded
shows only the image, no title or by clicking the white hamburger menu bar
captions. And the site's navigation is icon at the screen's top right next to the
accessed via a hamburger menu bar. search bar.
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Module 1: Cascade Basics | - Getting Familiar

Logging in to Cascade
Open a browser and enter the following URL (or click this link): http://
wcms.northwestern.edu/

You will be redirected to the NU Online Passport Single Sign-On page.
Enter your Net ID and password. Then press “Enter” or click “Log In.” Click
“Continue” if a security warning message pops up.

Security Warning i ll

e Although this page is encrypted, the information you have entered is to be sent over an
unencrypted connection and could easily be read by a third party.

Are you sure you want to continue sending this information?

: Continue

Cancel |

This security warning is not an indicator of an actual security threat; it can safely
be ignored while using Cascade.

e Information
You're logged in.

NOTE: On occasion after logging into Cascade, your browser may indicate you
are logged in, but not take you to Cascade’s Home Screen.

Should this error occur, simply return to the login URL (http://
wems.northwestern.edu/) and your browser will automatically redirect you to the

Home Screen, so you can begin working in Cascade.



http://wcms.northwestern.edu/
http://wcms.northwestern.edu/
http://wcms.northwestern.edu/
http://wcms.northwestern.edu/

Best Practice:

McCormick IT recommends Cascade users work in Chrome or Firefox.
Internet Explorer also works, but Chrome and Firefox generally perform

better.

Mac users are also advised to use Chrome or Firefox.

When previewing changes to your website in a browser, it is suggested to
avoid using Firefox since you may need to force its cache to refresh in order
to load your site’s latest content changes.

The Home Screen

The first thing you’ll see upon logging in to Cascade is the Home Screen, which serves as
a sort of home base for your work while logged into Cascade.

My Content

Recent Owned Content Drafts Workflows Locks

Stale Content

My Upcoming Tasks

Name

The Home Screen consists of two main areas:

* The toolbar, which runs across the top of the screen, allows you to perform
some actions, such as returning to the home screen and navigating to a specific
website.

* The dashboard / main panel, which takes up the majority of the screen,
changes according to the task you are performing. It offers a view of helpful site
widgets that users can add, remove or move.



The Toolbar

The Cascade’s toolbar in the Home Screen has been simplified to contain several
functions.

Some toolbar items are simply buttons; others are drop-down menus (indicated by a
double downward arrow ).

The functions available in the Toolbar are similar to those found on the Dashboard, but
are consistently available.

Sites Menu Search Menu Help Menu
Displays the websites you Provides search function for Provides additional
may access in Cascade. website assets in Cascade. resources to assist you.

Cascade Crescent My Content Button

Navigates you to the Displays content-related lists on
Cascade Home Screen. history, ownership, workflow, etc.

* The Cascade Crescent menu leads you to the Home Screen dashboard, with
user-defined widgets.

* The Sites menu gives you a drop-down list that displays the accessible websites,
and also a search bar to filter the sites list

* The My Content button is used to show you content-related lists of recently
viewed assets, content ownership, drafts, assigned tasks and more. This button
appears in the Help menu at smaller screen sizes.

* The Search menu provides a function to search for website assets and a shortcut
to a list of most recently viewed assets in the My Content section.

* The Help menu allows you to get in-system help such as reports and get to the
Cascade knowledge base for more technical information.

10



The Sites Menu

\’ ‘ ew Content
‘ This widget must be configured with a Site before it can display content.

Use the settings icon in the upper right-hand corner of this widget to

McC-Backman N
configure it.

McC-BTP

McC-CEE My Content

McC-CFL Recent Owned Content Drafts Workflows Locks

McC-CIGHT Office of Corporate Relations

T McC-McCormick
McC-CPCC McC-MAIN-Magazine

_trash
McC-Dean-Group
N Home

McC-Department-Template Home

Mc
" About the Department

Mc McC-DesignChicago Advising

Mc
events-common.css
M¢  McC-Environment

Mc View Entire History
M¢  McC-Farley

ae

You’ll notice a drop-down menu at the upper left of the Home Screen that says “SITE:
Go to a Site” by default. Clicking the down arrow on the menu tab reveals the sites you
have access to view and edit in Cascade. Also, you can type keywords to filter the site list.

Once you choose a website, then you are redirected to the Site Content page as below.

-~

[

SITE CONTENT

Nome o Order o Type Last Modified

Site Content

Navigation Panel

* Unlike the one in the Home Screen, the Toolbar menu on the Site Content page
allows you to add website content through the il button.

11



* The Navigation Panel window permits you to navigate the website content.
You can hide this panel at any time by clicking the arrow icon

* The Site Content window displays content details and previews.

The Add Content Button

The Add Content button is available when you browse to a certain site mainly through
“SITE: Go to a Site” drop-down menu, or a recent history link in “My Content >>
Recent” Widget. In the drop-down menu, you can either search for the site you’d like to
navigate to, or simply click it. In the My Content >> Recent Widget, you can click a link
to the site.

ew Conten

This widget must be configured with a Site before it can display content.
Use the settings icon in the upper right-hand corner of this widget to

McC-Backman N
configure it.

McC-BTP

Mcc-CEE My Content
McC-CFL Recent Owned Content Drafts Workflows Locks

McC-CIGHT Office of Corporate Relations
McC-McCormick

Mec-cpec McC-MAIN-Magazine

_trash

McC-Dean-Group
Home

McC-Department-Template Home
About the Department
McC-DesignChicago Advising

events-common.css
McC-Environment

View Entire History

McC-Farley

z z zz2Zz =z

If you click the Add Content button, a drop-down menu will appear. You can either
search for the name of an asset you’d like to create in the search bar, or select an asset
from the list.

There is a shortcut for creating a new asset in the New Content Widget of the
Dashboard. See New Content Widget section of this document for further instructions.

12



+ Add Content Site Content (ELFE]

‘ ': ter

[ Default

[ Faculty Profiles

a Affiliated Faculty Profile

0 Area of Study Data

a Basic Webpage

a Basic Webpage - No Left Nav
a Basic Webpage - No Sidebar
Course Description

Document - PDF, TXT, DOC, PPT, PO

® @

XL

%)

[/} external Link

The Navigation Panel

The navigation panel uses the “tree” structure that will be familiar to any user of
Windows: a listing of folders is visible, and the user clicks on each folder to view its
contents. Clicking the folder expands or contracts that folder’s contents, as shown
below.

McC-McCormick McC-McCormick

Closed ' Open
Folder Folder

To begin browsing the site in Cascade, click on a folder in the navigation panel to
expand the folder tree. Once the folder expands, the sub-folders and page assets are
displayed in the same directory structure that exists when published. Choosing a page in

13



the folder, such as “index”, will bring up a preview of the web page in the site content
window, just as it would appear online.

14



| The Contextual Menu
When you right-click on an asset, the contextual menuis 87"
displayed for that asset. The contextual menu is a shortcut McC-McCormick
that allows you to quickly jump into editing and other interna
functions available in the content page Toolbar, without t
waiting for the page preview to be loaded in the Site eadership
Content window first. B a-different-way-of-thin

View

Edit
Publish
Move
Rename
Copy
Delete
Unpublish

Access
Check-out/Lock
Relationships
Audits

Versions
Reference
Tasks

The Trash Bin

The Trash Bin contains assets you and other site users have recently deleted. These
assets are kept in case of accidental deletion. Note that assets in the Trash Bin are
deleted permanently after 15 days.

Access the trash bin on top of the navigation panel.

SITE CONTENT @ Tt
Bkck to all content

#ormick av
terna
Name Deleted

a few sec

S ict

g about-mccormickk
by &

To restore an asset to its original location, select the asset and click the
leftward curve icon on top of the Trash list.

15



The Dashboard
My Sites Widget

If you have access to more than one site in Cascade, you will see a list of recently
visited sites under the My Sites widget. This allows you to quickly navigate to the
site(s).

(& v A Q Wy =

o
1 6 My Content

Recent Owned Content Drafts Workflows Locks

<+ Add Widget C Reset Dashboard

My Upcoming Tasks

Name

16



My Upcoming Tasks Widget

This is a new feature in Cascade 8. You can also create a task by clicking Add a Task
button. When you click add a task button, a pop-up window appears where you can
enter a Name for the task, a Description, Assigned User (by default it’s assigned to
the person creating the task), set a Priority, enter a Due Date and list any Related
Content (for example —a file or image, or a webpage)

My Upcoming Tasks + Add a Task

Name

You have no tasks.

Create a Task

Name *

This field is required.

Description

Assigned User

User Assignment

Priority

Normal v

Due Date

mm-dd-yyyy hhimm a

Related Content

|!Choose Site Content

17



| New Content Widget

This widget provides a shortcut to create new content  :\ow content
This widget must be configured with a Site before it can

on your site. All available asset types are listed. If Sapiog oo, Une the st ion T the uper it
you're logging in for the first time, to see available hand corer of this widget to configure i

‘ assets, click the pencil icon that appears in the top
right corner when you hover over the widget to configure it for a website you have access

to.

Select the appropriate asset type from the icon list when you need to create a new
webpage, or create a folder, or upload a new file.

New Content
McC-McCormick

5 | &

Affiliated... Area of Study
Data

Basic
Webpage -...

Show 9 More

Course
Description

18



My Content Widget

You’ll find a list of recently clicked assets My Content

under Recent, saved drafts under Drafts Recent ~ Owned Content

and assets that you've checked out to yourself JiiE =R s s Suswn

under Locks. Most of our sites don’t have i

Workflows. Just switch to the appropriate Cl:JT\lIJ;EL—Dept—Top-NanA

subtab to see the relevant content. o
screen-shot-2017-05-07-at-10.18.23-pm.png

By default, Recent is displayed in the My :ﬁ‘“’:wge

Content section at the center of the option3.jpg

Dashboard. There are other ways to get
access to Recent.

View Entire History

Stale Content Widget

Stale content widget shows you when the [l aials

. This widget must be configured with a Site before it can display content.
site content was last updated. If you’re Use the settings icon in the upper right-hand corner of this widget to

logging in for the first time, click the by
pencil icon in the top right corner to select
your site and set the time period to determine content staleness.

After you've configured it, you will see a chart showing the number of stale vs fresh
assets. You click on the link Showing total assets last updated 30 or more days ago to see
a full list.

Stale Content
UNIVREL-Dept-Top-Nav-QA

A

54

Showing total assets last updated 30 or more days ago

If you expand Filter Results option, you’ll see the options to change the number of
days and include the folder you need to routinely update. In this way, you can exclude
sections that don’t get updated often.

19



Notification Widget

The Notifications widget lists messages related to
publishing and un-publishing of an asset. Any errors or
issues with your publishing jobs will be logged here.

< v

Report: Stale Content

0 elcome bac =73

+ Add Widget C Reset Dashboard

My Sites
McC-McCormick
McC-NU-Template
McC-SegalDesign

WCMS-Commons

My Upcoming Tasks
Name

You have no tasks.

Stale Content
This widget must be configured with a Site before it can display content. Use
the settings icon in the upper right-hand corner of this widget to configure it.

My Content

Recent Owned Content. Drafts Workflows

McC-McCormick
upcoming-events
index

News Index

News-Events Page

er-dev

per-block

View Entire History

Reconfigure Dashboard

* You can drag and drop widgets to rearrange them on your dashboard.
* You can add/remove widgets by clicking on Add Widget button.

Assets

What’s an Asset?

In Cascade, the word “asset” is a blanket term for any object loaded into, or created in, the
Content Management System.

An asset can refer to:

« a web page « an image file (photo)

«a PDF
« an external link

« an MS Word document

¢ an internal link

« a folder

Locks

Publish of P;

Un-publish
Un-publish of File "McC-N
Un-publish of File 'McC-NU-Template:c

Un-publish of File McC-NU

iblish of File McC-NU-Ter
Un-publish of File 'McC-NU- events-styles,

Un-publish of File 'McC-NU-Templa completed (

ntent to Revie
This widget must be configured with a Site before it can display content. Use
the settings icon in the upper right-hand corner of this widget to configure it

Link Checke
This widget must be configured with a Site before it can display content. Use
the settings icon in the upper right-hand corner of this widget to configure it.

* an MS Excel document

20




Naming Files, Folders, and Webpage Assets
Since asset filenames become part of their URL addresses and also affect how readily
your website appears in search results, it is important to follow certain conventions as

you name your assets in Cascade.
When providing the Asset Name in Cascade, please follow these guidelines:

* Asset Names should not contain any spaces and should not be unnecessarily long.
* They should use keywords, all lowercase, separated by hyphens.

* They should not include dates that will expire.

Here are examples of good and bad Asset Names:

GOOD BAD
catalysis-research-laboratory.jpg CatReschlab.jpg
john-smith.jpg John Smith Good Headshot1.jpg
john-smith-publications.pdf Johnsmith_ Pubs_9-12-11.pdf
smith-group-newsletter.pdf SmithResearchgroupNewsletterApril2o12.pdf
research-safety-guidelines.doc Rsch Safety 2011 Guidelines.doc

Following good hygiene when naming your assets also saves you time and trouble as you
organize and maintain your website content in Cascade.

21



Module 2: Editing a Basic Page

To edit a basic page, select that page from the left-hand navigation tree in the content
page. Then choose "Edit." This will bring up the editing view of the page. Here's a look
at the editing view of the "About McCormick" page of the site:

8 (& o g - Save &

Content Preview

Display Name *

About

Title *

About McCormick

Keywords

whole-brain engineering, design thinl

Description

Learn about the McCormick School o

Display Page in Left Navigation?

No v
Basic Page
v Main Content

v Header Image(s)/Slider
Include jump menu? *
@® VYes No

v Jump Menu

Body Content | | Images = portrait (width 150px); landscape (width 250px); full-size (width 670px)

Edit ~ Format ~ Insert ~ Table ~ View ~ Tools ~

r
w
~
Ic
(il
Ll
il
Il

Formats ~

i
4
i
4
Jiil
hil

r
KA
L'

Page Location/URL

At the top of the site content window, you'll notice

29 & Page: about mcCormick
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the indication of the page's location in a path directory format: about/index.

This indicates that the page has an Asset Name of "index" and is located in the "about"
folder. It also indicates what the page's url is: http://mccormick.northwestern.edu/
about/index.html

Note: Because this is an index page, http://mccormick.northwestern.edu/about/ will
also direct to this page.

Inline Metadata

When editing an existing page, you'll notice the "Inline Metadata" section is filled in
with the page's "Display Name," "Title," etc. The Display Name appears in the left
navigation of the site and the "You Are Here" breadcrumbs. The title appears on the
actual page.

Northwestern University NORTHWESTERN ENGINEERING v

Northwestern | ENGINEERING Q

OFFICE OF MARKETING AND COMMUNICATIONS

Display Name Display Name

N THIS SECTION

V vou ARE HERE

Marketing Home
OFFICE OF MARKETING AND
COMMUNICATIONS

Contact Our Team
Marketing Services
Logos and Branding

Web Resources 47-467-4(
Email Kyle

Event Planning and .
McCormick Office of

> o
Promotion X Tltle Marketing and

O \/e r V I e W Communications Staff
Digital Hallway
Signage

. .

Our Mission

Templates & Door

r Y 1 J acrc Al me ) platf reinforcing B iy

WAL LA AT N

Learn more on how to fill out this section in the "Include Metadata" subsection of this

guide.
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Header Image/Slider

If you would like to include a header image or slideshow at the top of the page, click the
downward arrow v to expand the Main Content > Header Image(s)/Slider section.

As you answer the series of "Yes/No"
questions about your image(s)/slideshow,
options will appear to further indicate
specifications such as:

* one header image or a multi-image
slider

* automatically cycle through images on
the page or leave it up to the user to
advance the slideshow

* advance slides every 20 seconds
(default) or for a number of seconds

you specify

Main Content

v

Header Image(s)/Slider
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Would you like to use a header image?

@ Yes No

mage (770px x 375px) *

B about-global-vision.jpg

Caption (max. 130 characters) *

Initiatives extend around the world, f

Display this caption?

@ Yes No

Link Type

nterna External

@ No Link

Would you like to create a multi-image slider?

@ Yes No

Randomize the first slide on page load?

@ Yes No

Automatically advance the slide images?

@ Yes No

Slides advance every 20 seconds. Would you like to change that?

@ Yes No

Modify the rotation interval. Enter number of seconds (default =

10

20)




If you've chosen to create a multi-image slider, the area to add the image and caption for
each slide will appear below the options:

Click the downward arrow v to expand this section and edit the
fields for the slides. Add more slides by clicking the green plus sign Vv
at the top right of the expanded slide area.

Additional Image

Jump Menu

The basic page type has a Jump Menu option to create a list of links to various sections
of the page. This is ideal for lengthy pages on a responsive site so mobile users can skip
to the information they’re looking for rather than scrolling through all the page’s
content.

1es

Faculty and students turn ideas into businesses through entrepreneurship
14 courses, incubator space, and campus advising resources.

OFFICE OF Tt
ABOUT McCORMICK<+~—— Title Dt
y Journal Covers = Seeal
School
Since 1909, the McCormick School of Engineering has sought excellence in achieving its 2145 Sheridan
two parallel missions: to produce new knowledge and to engage and educate students. Road, Room L
McCormick fosters a culture in which innovation is not only encouraged, but expected. Evanston, lllinc
That culture still thrives today, driving new initiatives, research discoveries, and superior 847-491-5220
education. € Email Dean Of
— ——Preface Content
Carol M. Berry
Jump Menu :
- x e Dean’s Assista
Jump to a Section 1st Anchor Link
Tech L262
- - 847-491-5220
¥ Whole-Brain Engineering Email Carol B
¥ Design
¥ Entrepreneurship and Innovation
i SENIOR ASSC
¥ Leadership DEANS
¥ Global Vision
Richard M. L
¥ Collaboration and Balance ithonh 3
Senior Associa
¥ Facts and Figures Operations anc
2145 Sheridan
Room L258
Evanston, lllinc
1st Anchor i
o A/ Phone: 847-49
WHOLE-BRAIN ENGINEERING Fax: 847-491%
Email Richard

Engineering is an activity grounded in analysis, logic, synthesis, and math—all
To use this menu, select "Yes" for "Include jump menu?" Click the "v Jump Menu" box
that appears. You'll first notice an area for optional Preface Content, which would
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appear above the jump menu on the page. Use this area for an introductory message to
your page if necessary.

Below is the area to create your menu links. You must fill in the field for the link Text
(the text that will appear in the menu on the page) and the Anchor Name (the section
of the page you to jump to). Then, you must create anchors with the same names
used in the Body Content section in the area of the page you wish to link to. See the
"Anchor Links" section of this guide to learn how to create anchors.

Include jump menu? *

@ VYes No

v Jump Menu

Preface Content (optional)

w
~
Ic
(']
(]
[ihl
(Il
n
A
i
)
i
)
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[l

<
Qo
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v Page Anchor

Text*

Anchor Name *

anchor
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Editor Toolbar - WYSIWYG

Since Cascade uses a WYSIWYG (What You See Is What Importa nt!
You Get) editor, the formatting you apply to your content

. o . . Use only Cascade’s built-
is generally how it will appear on your website.

in formatting tools!
McCormick IT has configured

Cascade’s editor toolbar lets you apply the same basic Cascade’s text formatting to
formatting you’d have access to in any word processor — ensure that web pages are
headers, paragraph (body) copy, bulleted and numbered ’:‘hl::)fl?g:hmojtnlc\j/lgggfr:i::int
lists, bold, italics, and much more. websites.
Many of the options on the Cascade editor toolbar fAS SUCh:k?ditOLSf Sfjtomdtrefratig

. . . oo rom making agjustments 1o the
(especially the ones on the left §1de) will be familiar to HTML code that would do things
users of common word processing software. You can like changing the font size,
perform many of the same actions to format text as you color, or typeface.

can in a program like Microsoft Word.

Set / Edit Insert / Edit Insert / Edit Full Screen
Formats Anchor Video Mode

Edit+ Format~ etv Tablev View~

o B 7 Formats ~ : /<> ey
Link / Unlink Edit Source Edit Source
Code Code

There are six drop-down menus in the toolbar as follows:

Edit menu allows you to edit content through undo, redo, cut, copy, paste, paste
as text, and select all functions.

Format menu enables you to set the format of content to bold, italic underline,
strikethrough, superscript, subscript, and to clear the formatting. You can also
access the Formats menu.

Insert menu contains functions to include links, anchors, images, media, special
characters, horizontal lines, and data/time.
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Table menu allows you to insert and edit tables. It is advised to not use tables

on the site. If you have information that absolutely needs a tabular display,
please contact marketing at web-updates@mccormick.northwestern.edu.

View / Tools menus provide functionality to help users in terms of view,

spellcheck, and source code.

Also, there are some shortcut tools — noted in the graphic above — that may require
some additional explanation with regards to how they function.

.

KA
"S"

Formats ~

Link/Unlink: These tools will allow you to create/edit hyperlinks out
of any text or image within your body content.

Insert/Edit Anchor: Anchors allow you to mark points anywhere on your
web page so that they can be easily accessible by users. They are most often
used on web pages with a large amount of content, as they offer the ability to
go directly to a single piece of content rather than scrolling down through the
entire page.

Insert/Edit Image: Select this icon to insert an image into your page.
Please read the “Inserting Images” section of this manual for important
information on this process [page 00].

Insert/Edit Video: Select this icon to insert a video into your page. Please
read the “Inserting Videos” section of this manual for important information
on this process [page 00].

Edit HTML Source: This option allows you to take a look “under the hood”
at the actual code that you're creating through the Cascade editor. However, it
is advisable to leave this alone unless you are familiar with HTML code —
changes made here can affect the functionality of your site.

Full screen Mode: Clicking this icon will move your view to a full screen
mode in your browser to allow for added working space. Click the icon again
to return to the standard view.

Set / Edit Formats: Clicking this drop-down menu will provide a

shortcut to set or edit headings, inline, blocks, alignment, and custom
classes.
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NOTE: You will notice buttons in the editor toolbar to “underline,”* and
“indent”*= = text in the editor window. Those styles are not preserved when you
submit your page in Cascade and will not publish.

Basic Formatting

Formatting text as bold, italic, underline, and setting its alignment to left, right, or
justified, works the same in Cascade as it does in any word processor: Simply select the
appropriate text, then apply the formatting you want it to have.

NOTE: Cascade is currently configured to remove the “centered” formatting available in
the WYSIWYG editor. If you want to center-align any text, use the “Formats” drop-down
menu as explained earlier.

Headings and Subheadings

It is important to keep your content well organized Best Practice:
so your visitors can easily navigate and find the
information they need. Use headings and
subheadings on your pages to create a visual
hierarchy for your visitors, similar to a document
outline.

Use Headings and Subheadings
Frequently!

» Use “Heading 2” to make a header in
your page’s main content area.

.. » Use “Heading 3” to make a subheader
To create a heading in Cascade, select the text you i, page’s main content area.

wish to use as a header, then, in the Cascade

Editor window, click the “Formats” drop-down For additional information on using
menu and then “Headings” menu. Finally, select headings and other formatting to improve
“Heading 2” or “Heading 3.” your website’s searchability, read the

section of this guide titled “Optimizing
The importance of a heading descends as its Your Content”.

number ascends, so information used as a Heading
2 should be more important than that of a
Heading 3.
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locks »
Custom
HEADING 3
Heading 4

Heading 5

Headings ' HEADING 1
HEADING 2

L%
L

NOTE: With this website template, you should not use any “Heading 1” or “Heading 2”
formatting, since Cascade automatically formats your site and page titles to those

headings.

Copying and Pasting

As you build and maintain your webpages in Cascade,
you can type in your content by hand using the
WYSIWYG content editor. You may find you need to
input larger amounts of content from Microsoft Word
documents or Adobe PDF files.

Before copying and pasting any content into Cascade,
please review the following:

In most cases, copying and pasting directly from
Word or PDF documents into Cascade is not
recommended. Documents from word processing
programs often contain hidden formatting which can
create errors in the way content is displayed on the
web.

Important!

Clicking the “Cut,” “Copy,” or
“Paste” buttons in the Cascade
editor don't work.

Use keyboard hotkeys instead:

Cut: “Control + X” (for PC) or “Command
+ X” (for Mac)

Copy: “Control + C” (for PC) or
“Command + C” (for Mac)

Paste: “Control + V,” (for PC) or
“Command + V” (for Mac).

To remove hidden formatting, it is recommended that you select the “Paste as Text”
located in the Edit drop-down menu in the toolbar. With that button selected, text you
paste into Cascade will automatically be stripped of any hidden formatting.
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Another option you could use is to first paste your
Edit ~ Format ~ content into a plain text editor such as TextEdit or
Notepad. Make that content “plain text,” and then copy
and paste it again from there into Cascade. That process
will strip any hidden code that you may accidentally
v Cut include with your content.

¥ Paste
Whenever you paste or enter text into Cascade,
you will need to reformat your text using the
ct all tools in Cascade’s editor toolbar, creating headers,
paragraphs, links, and other formatting manually as
desired.

Making sure your text is pasted into Cascade as plain text will ultimately save you a lot
of trouble later and ensure that your content appears exactly how you would like it to
appear on the web.

Inserting and Editing Links
To create a hyperlink on a line of text or an image, highlight that

piece of text or the image you’d like to link and click the chain-link
button in the Cascade editor toolbar.

From there, you will need to specify the Insert/edit link
following: Link Source (STinemal[ | Extema

9’ Choose File, Page, or Link
.

whether the link target is an internal
page or an external URL

whether the link will open in the
same window or in a new window

what the link’s title (which appears as
the floating “tool tip” when a user
hovers over link text) will be

NOTE: External links that go to

webpages that are not part of your own site

should open in a new window. Internal links to pages on your site should stay in the
same window.
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To create a link to someone’s email address, select the external
link option and type “mailto:” followed by the desired email address in the
URL field. For example, if you wanted to link to John Smith’s email address, type
“mailto:john.smith@northwestern.edu” (without quotes) in the external URL field. In
the “Title” field, enter something like “E-mail John Smith.” When a visitor clicks on that
link on your website, their default email program will open a new email to that email
address.

You can also use this tool to point to a page anchor, which is discussed in more detail
below.

To edit a link, select the link in your editor window and click the chain-link button in the
editor toolbar. You can modify the link’s attributes there.

To remove a link, select the link in your editor window and click the broken chain-link

button in the editor toolbar.

Anchor Links

Anchors allow you to mark specific points anywhere on
your webpage that can be linked to from external
pages. For example, using an anchor link, it would be
possible to link to, say, the third paragraph of a page,
rather than the top of that page.

They are most often used on Web pages with a large
amount of content, as they offer the ability to go
directly to a single piece of content rather than
scrolling down through the entire page. For example,
the “back to top” links often used in long lists are
actually pointing to the same page anchor at the top of
the page.

To insert an anchor:
1. Go to the area of the page where you want the

anchor to be (usually near a heading) and click
the anchor tool.

Anchor
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Important!

1. Anchor names should be

treated as Asset Names:
Use lowercase keywords
separated by hyphens. Do not
use spaces or special characters
in your anchors.

2. Keep close track of your

anchor link names!
Cascade’s system for linking to
anchors in a page does not
provide a list of anchors to
choose from — you have to enter
the anchor name yourself. If the
anchor name you enter isn’t
exactly right, the link won’t work!

3. Always test your anchor

links after publishing them.
If you find problems, it’ll be much
easier to correct them
immediately than it would be
hours or days later.



2. Enter an anchor id (name) and click “Ok.” Anchor names must start with a
letter and cannot include spaces.

3. When you want to link to that specific section from a table of contents at the top
of the page:

a. Use the link tool as you would for an ordinary link, but rather than
choosing an external page to link to, enter the name of the anchor link on
the current page.

4. When you want to link to an anchor on a page other than the one you’re
currently editing:

a. Use the Link tool to select the page elsewhere in the site.

b. Enter the name of the anchor link on that page in the “Anchor” field.

Sidebar Options

All pages have a right sidebar at v Sidebar

desktop size. You can include the VR o O
. . pply to Mclormic Yes No
fOllOWlng 4 Wldgets' Current Graduate
. . . Students v Related Links
Related Llnks (Optlonal) Fellowships & Internships
Header *
o Select “Yes” for “Include S Felered o
related info?” then click e
v Link Group

"v Related Links". Enter ~ ™cvPrecen
content for links. Click
the green plus icons

Group Header (if multiple)

to add another group/ v Link
indiVidual links- Bruce A. Lindvall =
Assistant Dean for - r\ 77777
* Contact Info (required) Graduate Studies —
847-491-4547
= Link Type
o Enter contact smnlBores @ Ineerma Excerns
information' CliCk the Paula Straaton nternal UR
green plus icons to Business Administrator, @ el
add another group/ =
. .. 847-491-3553 v Contact Info
individual contacts. Email Paula
v Group
Contact the Office of
Graduate Studies Group Header (optional; ex: Undergradi
e De.
. Contact In
* Call-out (optional) Edt Wsat~ View- Todse

1]
1]
il
1]
iii
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o Fill out the Header and

Include Call-out? *

Content regions REQUEST INFO @ ves No
ABOUT A
* Sidebar Feature (optional) PROCRAM o callout
To add, select "Yes" for Request a customized e-
"Include a Sidebar Feature?" ';r:far:s“ RS D Header: *
Then, click the "v Sidebar Ideas at the Intersection
Feature" box. You can create a LEARN MORE > —_—
feature for the specific page . : ”
you're editing or use a feature B| | Edtv Fomst- fneetr Table- View-
block, which can be added to ® e
multlple pages. v Sidebar Feature

o Create a feature: Select
an image with

Select a feature block or enter a feature on this page?

Featureblock (@) Create afeature

dimensions 242 by FROM LAB TO

170pX and fill out the EUSINESS v Feature

Headel‘ and Content Graduate students learn mage (242px x 170px) *

I‘egions_ Select the the commercialization - _

"y 3 k " -f process through the B Choose File
Lln Type 1 you Want Innovation to

the feature to link to Commercialization (12C) Header*

and Center for Device

another page. To add
slides, click the green
plus Sigl'l at the tOp LEARN MORE >
right.

Development fellowships.

Content: *

Edit~ Format~ Insert~ Tablew View~w

o Feature block: Select this option if you would like to insert a general
sidebar feature bloc for more than one page. Sidebar feature blocks are
stored in the “sidebar-features” folder and each will have a block icon @

To create a new general sidebar feature:

1. Goto “Add Content—>Sidebar Feature” and give your general feature a
descriptive Asset Name.

2. Fill in the appropriate fields for your slide(s) and submit.

3. Publish any image assets added to the block separately. [RRSSISBACRNEES

Unfortunately, the images won’t appear in the sidebar At the tablet and mobile phone
slideshows if you have not published them separate from screen sizes, the Sidebar
the page(s) you add the block to. Feature does not display.
Related Links, Contact Info and
4. The feature-block will be stored in the “sidebar-features” the Call-out move to the bottom

folder and you can choose to add it to any page by of the page.
selecting the Feature block sidebar option.
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Draft

A “Draft” is exactly what the name implies: a working, but not complete, copy of a
webpage with changes in progress. Drafts are automatically created and periodically
updated as you work on a page.

Content

To save a page as a draft, click the “Save & Preview” button at
the top right of the Edit window. This allows you to view your

draft after saving it.

Drafts are useful when you’re working on a page but need to
stop and focus on something else for a while. If you go back in
Edit mode, you’ll see a yellow bar with three options:

Adraft of this page was saved 7 minutes ago. Do you want to preview the changes, resume

editing or discard it?

a. Preview the changes — If you click here, you see a
preview of your draft. You can also see a preview of the

© o

Metadata Configure ullscreen

last saved version from here.

b. Resume editing — allows you to edit your draft.

c. Discard it — if you click here, your draft will be

discarded

You can find all saved drafts under the My Content widget on

your Dashboard.

My Content

Recent Owned Content

Role-based Navigation
Tools

dean

index
organization-chart.pdf
Events Page

Standard Left Nav Page
Standard Left Nav Page
Standard Left Nav Page

View All Drafts
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Im!:ortant:

You dre the only person
who can see your draft of
a page.

If you’'ve made changes to a
page but saved it as a draft
(instead of clicking
“Submit”), other users will
not be able to see your
changes when they open
the page.

If you need another user to
see your changes, go ahead
and click “Submit” — it's
easy to roll back changes in
Cascade, if needed.



Save & Preview Vs. Submit

In Cascade 8, Save & Preview is the default option to save a draft and preview your
edits. Save & Preview does not submit your work! After clicking Save & Preview
the asset will reload with your edits, and a message will appear in the top right corner of
the editing pane. This temporary message confirms that a draft has been saved and
prompts you to Submit your work before fading away. You can select the “Click
Submit” link text in the message before it disappears or the blue Submit button at any
point.

Your Draft is saved! I

Click Submit to save your changes to the current version.

If you’d like to skip the Save & Preview option and 7 - @
submit your draft, you can click the three-dotted e
button at the top right corner of the editing Comment on the changes you made

window. A window will appear to “Check Content
& Submit”. If you click the button Cascade
performs guided content checks before submitting.

Submit now or perform guided content checks. »

—
G Check Content & Submit )
—

NOTE: After clicking the blue check mark B4 after the guided Check Content & Submit
process, you save your work in Cascade. You still need to publish it to the live site.

Submit Vs. Publish

Submitting a page or asset saves that version in Cascade and allows other users to view
your changes. When you return to that page or file in Cascade, even after logging out of
the system, it will display the most recent updates that were submitted. However,
submitting does NOT put your pages or files on the web. You must publish
them.

Publishing is the process by which your pages, folders, or other assets are copied from
Cascade and put onto one of McCormick’s public web servers. Publishing a page, folder,
or other asset, makes that content visible on the web. Conversely, un-publishing
removes content from the web.
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Publishing or Un-publishing Your Assets

Clicking “Submit” or “Check Content & Submit” at the top right of the page you're
editing saves your changes in Cascade. However, it will not yet appear on the web.

After submitting your changes, your page still needs to be uploaded to the
web server. That process is called Publishing.

The publishing process is simple:

1. After submitting, click the “Publish” tab at the top of the page preview window.
You can also hover over the page in the left navigation panel and click the white
down arrow that appears next to the Asset Name and select “Publish.”

& 20it . & Publish (] Comments (D Details  «= More

Output: HTML v

2. You’ll see two areas of the screen, where you’ll configure the publishing process

for your pages:
*Output:
Publish page — .
McC-McCormick: /about/index o ThlS area
displays in
Generate a publish report What kind Of
Select one or more of the outputs to publish to the destinations selected below: OutputS you,ll
be publishing
Output Publish your edits tO
the EHT™ML All Destinations servers.
Destination
03 Development Website
) Live Website

* Destination: This area shows to which servers you’ll be publishing your
edits. Here you should see two options with check boxes. Those options are
the two servers you can publish to:

o “Development Server” is your site’s development server, on which
you can test your website. You can view pages published to this
environment at http://mccormick-dev.tech.northwestern.edu.
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o “Live Server” is the live server. This option makes your content
fully live and viewable by the public.

Both will be checked by default. If you want your changes to go live immediately,
select “Submit.” If you want your changes to show up on the development server only
(for example, you might want to show someone a set of proposed changes to your
website), uncheck “Live Server,” leaving only the “Development Server” checked.

Options: “Generate a publish report message,” if checked, means that you’ll receive
a message within Cascade’s internal messaging system (viewable from your
Dashboard or from the “Messages” link in the Quick Links menu) confirming that
your page was published, and what errors, if any, occurred during publication. This
is good to have, but not necessary.

“Publish” and “Un-publish” mean exactly

Important: what they seem to:
When creating a new page, changing a

page’s display name or removing a page, » .« 19 ,
you must publish the parent folder that Publish” updates the page you've altered

contains that page/folder to update the left- Ol the server

hand navigation throughout that area of your .

site. *“Un-publish” removes the page from the
server entirely.

3. Once you've selected the configuration you want, click “Submit” to publish your
page. You'll get a confirmation message in a green bar at the top of the page.

Publishing is generally immediate and can be done as often as needed.

To view your latest published changes in a browser, you may need to refresh the page or
clear your browser’s cache so it pulls the most recent information from the server.
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The un-publishing process is simple:

1. Go to More—>Un-publish and make sure you have the correct destination
selected for un-publish task.

My Content Q Search T v =

# it @pPuslish [ Comments (@ Details

Unpublish

Access
Access for contents

Workflows

Type Last M¢  Relationships
Audits
~older ayear: Tasks

2. Locate and click the Submit button to un-publish. This will remove the asset
from the live server but it will stay in Cascade.

Publish folder

Cance bmit
UNIVREL-Dept-Top-Nav-QA: / '
Generate a publish report /

Select cne or more destinations to publish te

Destination

) Test Web Site

Publish Summary

You will be publishing to destination{s) Test Web Site.

3. To ensure that the un-published asset doesn’t show in the navigation of your site
and stay out of publish queue, re-select the asset and go to Edit tab. Change the
Display in Navigation setting to No. Then, go to Configure (Properties for a
folder) and uncheck include when publishing checkbox. Locate and click
Submit to save your changes to Cascade.

4. You may need to republish the parent folder of this asset or the whole site if the
asset you just un-published appears in the navigation of your site.

Warning: When you un-publish, a visitor attempting to view that item will receive a
Page Not Found message. If this is problematic for your organization, you should
upload or create an asset using the old asset’s name.
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Publishing the Entire Website

When you update a common element, such as your top navigation or the footer, you
must publish the entire website. To publish the entire site:

1. Locate and click the root directory in the navigation panel or folder tree. It could
be name Home or the name of your site.

Edit

Unpublisn

Access

Accass for contents
Workflows
Relatonships
Audits

Tas«s

Name
/

o

2. Right click to see the in-context menu. This shows you some of the editing tasks
for a folder.

. . . . . Publish fold
with live/test destinations will UNIREL Depk-Top-Nev-QA:/

appear. Select the appropriate _

destination(s) and leave all other = “™™**" =" e
items CheCked tO ensure Select cne or mere destinations to publish te:

everything publishes to your live
site correctly. Destination

] @) Test Web Site

3. Click Publish option. A page M
Cancel

Publish Summary

4. Locate and click the Submit
button.

You will be publishing to destination{s) Test Web Site.
NOTE: If you would like to see where your asset is in the university-wide publish

queue, jump to View Publish Queue section of this document for further
instructions.
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Writing for the Web

When creating web content, remember two important ideas:

* Make your webpages easy to scan. Visitors are generally looking to find the
information they need quickly and move on.

* Make your webpages easy for search engines to find. This is
called Search Engine Optimization (SEO).

Having excellent content isn’t of much use if users can't locate it by searching. While
there are no guarantees when it comes to SEO, implementing the following best
practices may result in better search results.

In addition to improving SEO, the practices mentioned below will improve the
experience of visitors to your website and are an important part of complying with
accessibility standards for the web.

Optimize Asset Names

In Cascade, the names of the actual files and folders are called Asset Names. Asset
Names also become part of the webpage's URL that is visible in the address bar of web
browsers. It's important that they're consistent and optimized for search engines.

Asset Names should always be:

made up of keywords relating to the content

formatted as lowercase

separated by hyphens.
Do not use spaces or capital letters.

For example, "research-laboratory-staff" and "guidelines-for-faculty-publications.pdf”
follow best practices for Asset Names.

It's also best to avoid using dates in Asset Names. This prevents you from having to
create a new file or change the Asset Name if you need to update that information. For
example, "student-handbook.pdf” is better and easier to maintain than "student-
handbook-feb-2013.pdf." This also saves you the trouble of having to recreate the links
to that document on your webpages.
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Use Descriptive Page Titles

The page title is the phrase that appears in the top of the web browser bar while a user
views a page. Search engines weigh page titles heavily when determining search results.
This information also appears as the page title at the top of your webpage’s content area.

In Cascade, you can edit the title of your page under in the Edit tab, in the “Inline

Metadata” section where it says “Title.”

Include Metadata
In Cascade’s page editor, below the Display Name and Title fields,
you will see fields for Keywords and Description.

In the Description field, type a descriptive, concise sentence
explaining the contents of the page you’re working on. This
description will appear on Google’s search results pages.

Include relevant search terms in the Keywords field. This will also
help search engines like Google find your webpages.

McCormick School of Engineering | Northwestern University
www.mccormic... ¥ Robert R. McCormick School of Engineering and App

Learn about McCormick School of Engineering and Applied Science at the
Northwestern University in Evanston, IL . Find information about graduate admissions ...

Optimize Your Copy

* Make your page copy simple and concise.
* Break it into more numerous small paragraphs.

* Use bullet points whenever possible.
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About Us

Title *

About Northwestern Engineering

Keywords

whole-brain engineering, design thinl

Description
Learn about the McCormick School o
Display Page in Left Navigation?

Yes v




Use Headers and Subheaders

Google's search engine (and Northwestern’s internal search appliance) gives more
weight to pages containing search terms in header tags.

In addition, usability studies have repeatedly shown that users scan web pages, rather
than setting out to read them from top to bottom. This means that concise copy and
frequent (but judicious) use of subheadings is vital to making your pages useful to your
readers.

Using headings and subheadings frequently is also important to building ADA-
compliant pages: Screen readers used by people with visual impairments detect the
HTML code that indicates headers (<h1>, <h2>, <h3>) and pay more attention to them
than they do to ordinary paragraph copy — even if paragraph copy is set in bold or italic.

To create a heading or subheading in the Cascade content management system, select
the text you wish to use as a header, then, in the Cascade Editor window, click the
“Format” drop-down menu:

* For headers in the content areas of your webpages, use “Heading 2”

* For subheaders, use “Heading 3.”

B 7 Formats ~ = = & 2 N B o 2
L ' HEADING 1
Blocks 4
— HEADING 2
HEADING 3
Heading 4

Heading 5

The importance of a heading descends as its number ascends — information used as a
Heading 2 should be more important than that of a Heading 3.

With this website template, you should not use any “Heading 1” formatting, since
Cascade automatically formats your site title to that heading.
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Link Frequently and Use Keywords

If you mention a page or document in your text, link to that page or document,
particularly if it’s necessary to complete the task your visitor is trying to accomplish.

When choosing what words to activate as your link, it’s best to link to the key words in
that sentence, not the entire sentence. Also, avoid writing “click here” as your link.

Take the example of this sentence with a “click here” link:

“Professor Smith has worked extensively with the Smith Catalysis Laboratory (click
here for more info).”

It’s better to create the link like this:
“Professor Smith has worked extensively with the Smith Catalysis Laboratory.”

For detailed instructions on adding links in Cascade, see the “Inserting and Editing
Links” section of this guide.

It is also important to fill in the “Title” of your link.
LEARN MORE ABOUT

* Undergraduate study »

* Graduate study »

{'D [ Learn more about the graduate programs the McCormick School of Engineering offers.

RETURN TO TOP

The text you enter into the “Title” field shows Insert/edit link
up as the “tool tip” text that appears over a link
when a user hovers their mouse over it on a
finished page.

Link Source + Internal External

& Choose File, Page, or Link

Not only can this information be extremely .
helpful when navigating our website, it’s also a
requirement to keep a web page compliant
with ADA standards.

Learn more about the graduate program the McCormick
Target None v

link-arrows h

n Cancel
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Use Alt Tags on All Images

Cascade requires you to fill in the “Alternate Text” field (producing what’s known as an
“Alt” tag) when including any photograph. The Alt tag text becomes the image caption
on the page. Therefore, it’s important to use complete sentences to describe what’s
shown in a photo. Alt tags are a requirement for ADA compliance.
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Module 3: Images, Documents & Videos

Preparing Images

Before you upload your images into Cascade, it’s important that they meet best practices
for the web, which may require modifying image dimensions and file sizes before
putting them into Cascade.

With the McCormick template, you are using for your website, photos should follow the
guidelines below and be cropped to the following dimensions prior to uploading into
Cascade. Image sizes are measured in pixels (px). See the "Image Size Cheat Sheet"

Resolution of all images should be 772 pixels per inch (ppi). You can adjust the
resolution of images in a photo editing program.

All McCormick staff can download the latest version of Adobe Creative Cloud software
(includes Photoshop, InDesign, Illustrator, Acrobat, and more). Find instructions and
info at http://www.it.northwestern.edu/software/adobe

There are a few important things to keep in mind when preparing images:

* Keep the aspect ratio (the ratio of the width of the image to its height) the same
as the original file in order to prevent distortion. No squashed heads!

* Do not increase image dimensions. If you increase an image’s size to something
greater than its original dimensions, this will create a pixelated effect. Start with a
larger image and size down as necessary.

* Ifyou’re using Photoshop, be sure to select “Save for Web & Devices” when
saving your image and adjust the quality to keep the image’s file size under 60
kilobytes (60k) for larger photos.

Generally .jpg and .png file types work well for most images and photos. Use .gifs for
smaller images with blocks of color or animations.
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Uploading Image/Doc

1. After navigating to the content page of the website you are editing, select “Add
Content” > “Image — JPG GIF PNG SVG” for images and “Add Content” >
“Document — PDF TXT DOC PPT POT XLS” for documents.

- - -
‘ McC-McCormick v (4= Add Content = Site Content  Manage Site

SITE CONTENT (] ‘ Fitter

rthwestern Engineering

i Trash [ Default

[ Faculty Profiles

B Affiliated Faculty Profile

Northwest
lumni e Area of Study Data

B Basic Webpage ABOUT

B Basic Webpage - No Left Nav

a Basic Webpage - No Sidebar IN THIS SECTION
B Course Description About
ocument - PDF, TXT, DOC, PPT, PO
P Document - PDF, TXT, DOC, PPT, PO Leadership
T, XLS
[/} External Link Departments &
Institutes
File Folder
Facilities
BB Image - Affiliated Faculty - JPG, PNG
History

B Image - PG, GIF, PNG, SVG

2. You can either drag and drop the file(s) to the noted area or choose one or more
from your computer. You can upload more than one image or document at a time
without zipping the files first. When uploaded, you’ll see a preview and the
dimensions of the file(s). Do not alter the image size in Cascade. All image
resizing should be done in Photoshop or another photo editing software before
uploading the image to Cascade.

8 (o o] o savea [
Close . H
Content Metadata Configure Fullscreen Preview

File Name *

Placement Folder *

images

McC-McCormick: /images

Drop a file here or choose one from your computer
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3. Once you've found and attached the file, the name of the file will be populated in
the “File Name” field above.

a. You‘ can th(?n edit the name o.f the Important:
file in the field. Be sure the File Do not move your images or documents
Name of your new file follows the into any other folder besides images/
guidelines mentioned above (e.g., documents and their subfolders.
use keywords, all lowercase, no
spaces, words separated by
hyphens). Also specify the proper
file extension * Images go in your “images” folder.
(e.g., .pdf, .doc, .xls, .txt)

* Documents and non-image files go in
your “documents” folder.

b. Placement Folder: Click this
link to specify in which “images” or “documents” subfolder the file will be
stored. By default, any image file will be stored in the “images” folder and
any document will be stored in “documents”

4. Click Save & Preview. The next screen shows you a preview of the file. This is
just a draft of the file you just uploaded. If the file looks okay, locate and click the
blue Submit button on the editing screen.

Your Draft is saved!
Click Submit to save your changes to the current version.
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Inserting an Image on Page

Edit ~ Format ~ Insert ~ able ~ View 0ols ~

Ty LY
HoH N

1. Place your mouse cursor in the area of the copy where you want to place an
image, and click on the “Insert / Edit Image” icon (the mountain and the moon
picture) in the toolbar.

e}
N
|
i
Il
il
Il
T
4
i
4
i
4

2. Choose whether you want to create an internal or an external image. An internal
image (default option) is a file that is already in the system, or one that you
upload. (An external image is one that you link to using a URL. This option is
rarely used and is for images hosted by external sites.)

3. Next to Image, you will see the “Choose File” icon. Click on the icon.

Insert/edit image

v Int

8 choceern J

In the new image chooser window, you can either navigate to an existing image using
the default Browse option, search for an image, or click on the Upload option to upload a
file. If you choose to upload a new image into Cascade, always upload new images
to the images folder. If you are going to be working with a lot of images, you may
want to create sub-folders under the “images” folder to keep them organized.

4. Once you have the image selected, click Choose to close the image chooser
window. The image path will appear in the “Insert/Edit Image” window.

5. xIn the Image Description field, type in a text description of what the image
depicts in a complete sentence. This required text becomes the image’s caption
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W Insert/edit image

En General Advanced

\
Sy

b Image Source « Internal External l

| ‘ a '-.vhole-brain-homepa%pg ‘

mage :
Th 49

McC-McCormick: /images/homepadg/whole-bra
ou
an Decorative This is a decorative image, I\
di\  Image description Discover out whole-brain engine
o = =

of

Dimensions 601 x 548

Class None

on the page and ensures that if the image doesn’t load properly, or if a screen
reader is being used, the user can still understand what the content is.

6. While you can specify the width/height of the image here, it is highly
recommended that you size photos outside of Cascade, as explained in the section
of this guide called “Preparing Images”.

7. Click “Ok” for the image to be placed within the copy you selected.

Working with Images

Using the tools below you can shift the layout of your inserted images or edit and replace
the images on your webpages.

Assigning an Image Class

If you're planning on aligning an image to the right or left you must use the
“Formats > Custom” menu to assign it a “class.”

Aligning an Image to the Right or Left

1. Select the image in the Edit window.
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2. Click the “Formats” menu and then “Custom” menu. Select image floatRight Or
image floatLeft.

nsert v ablev View~ LINK-BTTN-BLUE
B 7 Formats v

Headings ’ ) -
Blocks ’ mage_floatLeft
; Custom ’ image_floatRight v

This will align your image to the right or left, and add padding around it, which keeps
page text from getting too close.

IMPORTANT: Image styles are “additive,” meaning the code created when you choose
a style or alignment is not removed if you choose another style for the image. To
change an image style or alignment, you must first select the image and
click the “Format > Clear Formatting” /- tool from the tool bar menu. That

step removes the previous alignment. Then you can select a new style or alignment from
the “Formats > Custom” drop down menu

51



Editing and Replacing Images

You may want to alter an image once you’ve added it to a page:

* Locate and click the appropriate folder. Typically, images are saved under images
folder.

* Click the image you wish to edit or replace. This will display a preview of the
image or file (some files will not display) in the main Cascade window.

* Toward the top of the main window, locate and click Edit. The edit screen will
load in the main window.

+ Add Content  Site Content  Manage Site

# Edit | @ Publish

B File: Deering Groundbreaking.jpg

|UNIVRELvDepthop~Nav-QA / images / Deering Groundbreaking.jpg |

* On edit screen, you will see the option to replace the image and a toolbar that
allows you to edit it. Make appropriate changes and click on Save & Preview

button.

* You will be redirected to the image preview screen and get a confirmation popup
at the top of the screen stating a draft was saved. If everything looks, click Submit
to save your changes permanently in Cascade.

* Go to Publish tab and publish your changes to the live site.

E b Q e Save & .
Close - H
Content Metadata | Configure | Fullscreen Preview

A draft of this file was saved 11 minutes ago. Do you want to preview the changes, resume editing or discard it?

. Drop a file here or choose one from your computer
To replace an image == P y P

To edit an image
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Next, go to More->Relationships tab and publish all relationships
if the file has any. You will need to select the checkboxes to select the @ o
assets that you want to publish. Move

Rename

Copy
Delete

NOTE: You need to publish relationships only when you move, rename

or delete a document or a webpage, or when you replace an existing D
document with a new one. You don’t need to publish relationships when = =7
you’re making any changes in the content itself.
Audits
If you have an alternate version of an image that you would like to upload .

Tasks

in the place of the current image:

Download

Preview

Navigate to the existing image file in the “images” folder.
* Once the file is selected, click “Edit,” then use the “Upload” option to upload your
new image. Cascade will point to the new image instead of the previous one.

Replacing your images assets this way instead of creating whole new files prevents
clutter in your images folder.

Inserting Video on Page

You have the ability to embed a video from YouTube so that it plays on one of your site’s
webpages.

To embed a video so it displays on one of your pages:

€ C f @ htps: T e LXe0
i Apps [EJ Gmail: Email from G... @ New profile | lynda.c.. & RTataglance ( [Home:Overview].. (= CascadeServer [ Kronot

Wy GRAN Y
RC... ¥ Responsive Web Des... (@) Marketing/IT - Pivot... »

D - .. o 1.Gotothatvideo’s page
on YouTube.

tudents Say

py the video url from

between ~—  theaddress bar

science engineering
medicine -technology

The Great Intersection: Whole-Brain Engineering at Northwestern University
NU McCormick

il = = [ 1,586

The Great Intersection: Whole-Brain
Engineering at Northwestern Universif
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In Cascade, select the Video Reel icon “*f and

paste the YouTube video url in the File/URL Insert/edit media
field. Uncheck "Constrain Proportions" in the General | Embed | Advanced
next line and enter the proper video dimensions:
670 x 377 for the basic page. _ : et
Click OK. A preview box will appear in your

editing window indicating its placement on the

page. You can preview the video on the editing “ I
window.

Note: If you do not enter the dimensions,
Important: the video will display with large black bars

_ _ above and below it.
Do not use the embed code method of inserting

videos on your page. You will receive and error
message while previewing in Cascade and on the
live site if published.

Video Embed Video Embed
w/ dimensions w/o dimensions

Starting Your Professional Life Taking Mindful Action: How to Perform at Your B

McCormick O%on of Parscral Development

Northwestern Engineering

4:

Shift attention to the
sensation of
connection between
your feet and the floor.

Jeremy Hunter, PhD

Publish this page to see how it appears on the web by following the instructions in the
section of this guide called “Publishing Your Webpages”
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Image/Video Size Cheat Sheet

Images must be cropped to the desired size before uploading to Cascade, using
Photoshop or other programs.

Always select “Save for Web & Devices...” in

Photoshop. Adjust quality of image to balance
image quality vs. file size. File size of images The new website templats is responsive, so
affects page load time and data usage on mobile. images will change in size and location

Important:

depending on the browser width or the device

Note suggested file sizes below (e.g., 10k, 40Kk, being used to view the website. Below are the
etc.). specifications people should use to create and

upload their images; the rest happens

i i : t tically.
All image resolutions should be 72 pixels per automatically

inch.
Dimensions noted below are in pixels.

If your image is a logo or has solid bands of color, save it as a .gif file to reduce file size.

Header Images
These images must be 770 x 375px wide. Try to keep file size below 100Kk.

Images in Body Area of Basic Pages

Full width images (spans full width of content area):
Images that span the full width of the main content area should be 6770 pixels wide.
Try to keep file size around 60-80k, depending on image size. Height can vary.

Images using “image_floatLeft” or “image_floatRight” styles:
If you want to wrap text around the image, when using “image_ floatLeft” or
“image_ floatRight” image styles:

Keep your image under 250-300 pixels wide (about half the content area). Again,
height can vary.

Smaller images should be around 40-60k.

Images on People Listings Pages
Thumbnail images should be exactly 100 x 100px, around 10-12k.
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Images in Sidebar Features
Microsite and department site administrators may want to add sidebar feature slides on
their sites. Slide images should be 242 x 170px, around 30k.

Videos in Body Area of Basic Page
Embedded YouTube videos should be 670 x 377px.
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Module 4: Cascade Basics Il — Structural
Additions/Changes

Creating Section Folders

The first step in creating your site’s structure is to create the folders that organize your
content.

When creating a new section of your site, you will use the Section Folder asset, which
creates both a folder with an “index” page inside. Both the folder and index page must
be edited. You'll learn more about index pages in the next section.

It is highly recommended that you create a Section Folder in Cascade for each
top-level link or section you would like to appear in your left-hand navigation, even
if you only plan to have one webpage in that section. There are two reasons for using
folders this way:

* Should you decide to add more webpages or content to a section of your site in
the future, you will already have the folder in place that is properly named and
ready to contain those additional pages.

* Should you decide to expand an area of your website from a single page to a
section containing multiple pages, without a proper folder structure, you would
need to change the Asset Name and location of that one page and possibly
others. Since the Asset Name becomes part of a page’s URL, this could lead to
multiple broken links for visitors who return to your site after the adjustment.

It’s best to start off with a folder structure that allows your website to grow.
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Since Cascade generates your site’s navigation from
folders and their names, it’s important to name them " s mccmccomicc v (@) Add Content  Ste Content  Mand

properly. This begins when you create a folder.

1.

SITE CONTENT

For this example, we’'ll create a “student-
projects” folder which will contain pages telling
visitors about McCormick student projects.

In the Menu bar, click “Add Content,” and then
click “Section Folder.”

Replace the default “section” name in “Folder Name” (Asset
Name) field with your new name. In this case, call it
“student-projects.”

NOTE: The names of all assets in Cascade, including
folders, should be lower-case and should substitute
hyphens for spaces. No Cascade Asset should contain
spaces in its Asset Name. In addition, it’s important to
use keywords in your Asset Names. The Asset Name
becomes part of the URL path.

Make sure that the “Placement Folder” shown is the one
where you want the new asset to “live.” You can change the
Placement Folder by clicking the input section. This will
open a new window that will let you choose the correct
Placement Folder.

Section Folder

Folder Name *

student-projects

Placement Folder *

McC-McCormick

Display Name *

Student Projects

Display Page in Left Navigation?

Yes

In our example, since we want the “students” folder to appear as a top-level link
in the site’s navigation, put it directly in the Site Name folder (Here, McC-
McCormick) which is indicated by [/]. If it is not chosen by default, select the

folder and click “Choose.”

The section below contains the Display Name for your new section folder and the
option to display it in the left navigation. New folders you create will be displayed
in the navigation by default unless you select “No” in the dropdown.

A Cascade asset’s Display Name is the name that appears in the left navigation

panel and the page’s breadcrumb navigation.
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Enter a Display Name. Display Names should substitute “&” for the word “and”
since space is limited in the left sidebar. In our example, you can name it
“Student Projects.”

6. Inthe area marked at the top with “Properties,” there are two checkboxes that
should be checked by default:

“Include when indexing” means that
the pages within this folder will be
included (and show up in) the left-hand

. . . Include when indexing Include when publishing
navigation of your site.

“Include when publishing” means
that this folder and its contents can be published with the rest of your site, so they
will appear on the live website.

7. Click “Submit.”
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Editing Index Pages

Once your section folder is created, you’ll notice an “index” page inside it. The index
page is the webpage that a browser automatically displays when a visitor navigates to a
folder. It’s the default or “start page” for visitors to that section of your website.

From the preview window of the index page, go to the Edit option.

& Edit | & Publis? [_v_] Comments O Details

The Display Name of the folder, rather than the index page, will appear in the
breadcrumbs and left-hand navigation of your website.

The Title will appear at the top of the content area of your page and also in the

browser’s title bar.
To improve your search engine optimization (SEO), complete the Keywords and

Display Name

Display name

‘ FAQs ‘

t Frequently A;(ed Questions

Title *

Title

Frequently Asked Questions
Test Page About

Display in Navigation? *

@) Yes No

Description sections. (See “Optimizing Your Content” for more information about
improving SEO.)

When finished, click the “Submit” button at the bottom of the page.
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Creating Webpages (Second-Level Navigation)
Pages that are not the “index” page in a folder will appear to a

visi’For asa second-level of links in your website’s left-hand Responsive Note:
navigation. The left-hand navigation
becomes condensed into the
1. (Optional): Navigate to the folder where you want to blue section menu at mobile
create a new webpage. (If you don’t do this now, you can screen sizes.

choose the destination folder in a moment.)

2. In the top Menu Bar, click “Add Content,” then choose
“Basic Webpage.” The “New Page” window will appear in
your Main Panel.

E b Q 03 Close Save & :
Content e Configure | Fullscree o Preview :

Page Name *

basic-page

Placement Folder *

McC-McCormick

Display Name *

Title *

Keywords

Description

Display Page in Left Navigation?

Yes v

3. Give your new webpage a Page Name.

Since your Page Name becomes part of that page’s URL, it is best to
give your page a Page Name that uses lowercase keywords separated
by hyphens. Do not use any spaces.

4. Ifyou didn’t already do so in Step 1, select the “Placement Folder” link and
navigate to the site folder where you want to put your new page.
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5. Enter your new page’s Display Name and Title in the appropriate fields, and (if
you have it ready) place your new page’s content in the main content field.

6. Click “Submit.”

NOTE: You will need to manually publish your changes; see “Publishing Your

Webpages” for more information on publishing pages.

Creating Third-Level Navigation

The website template used by McCormick allows for the
left-hand navigation to display up to three levels at
once, which enables you to better organize areas with a
large amount of content.

If you would like to create a third level of navigation,
create a new folder inside one of your other folders.
Then repeat the steps above to create a new section
folder and addition pages as needed.

NOTE: You will need to publish all folders affected by

your changes in order for the left-hand navigation on
your website to reflect the latest updates.
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Folder Order: Changing Your Site’s Navigation

This section explains how to change the order of folders, subfolders, and assets in
Cascade.

The left-hand navigation of your website is determined by the order of the
folders and assets in Cascade. You can reorder the folders and the webpages
contained within those folders, which will then change the order of links in your site’s
left-hand navigation.

In this example, we’ll be changing the left navigation of a

subsection of the site. @ Trash
1. Inthe navigation panel, hover over a desired sub-folder Home
and click “>” to display its content on the site content common
panel.

2. Click the column header marked “Order.” The assets
should reorder from lowest to highest. If they don’t, click
“Order” again to reverse the sort order. Note that this

sorting is necessary for any re-ordering to work.
# et @pudlish  [J comments (@ Details

Folder: About
UNIVREL-Dept-Top-Nav-QA / About

Click here to see the current order

v
Name a Order Type Last Modified o
& About 2 Page 2 days ago
& Events Page 1 Page ayear ago
a Frequently Asked Questions 4 Page 7 days ago
& standard Page 3 Page ayear ago

a Test Page About 5 Page an hour ago

3. Click and drag each folder/file to the desired position, or use the arrows at right
to move them up or down in the order. Your changes will be saved automatically
when you navigate away from the folder.

NOTE: In order for these changes to display on the web, you must re-
publish the entire folder you’ve re-ordered. See “Publishing Your Webpages” to
learn more about publishing your website folders.

63



Copying Folders/Files

To copy a single folder or file, click on the folder or file and select Copy from the top
menu. Specify the new system-name for the copied asset and new location. Submit.

To copy multiple folders or files at once:
» Click on the parent folder of the asset
« Check the boxes of those you want to copy
« Inthe dropdown box below the asset list, select Copy
« Specify copy location

Moving Folders/Files

To move a single folder or file, click on the folder or file and select Move from the top
menu of the site content page. You can also hover over assets in the left navigation panel
and right-click and select “Move” from the contextual menu.

My Content  Q Search T v =

C] Comments @ Details **+ More

Rename
Copy
Delete

Unpublish

On the next screen, select a New Folder. This opens a window that allows you to view
folders within your site.

Move page
UNIVREL-Dept-Top-Nav-QA: /About/index

New Folder *

Workflow

Unpublish Content

Unpublish from Destinations

Previously published versions of the asset will remain on the webserver with the old path unless unpublished.
Unpublishing from the remote server will delete the out-of-date content from the chosen Destinations.

QOutput Publish
el All Destinations
Destination

Q) Test Web Site



In the folder navigation window, you can choose from the list

of Recent folders, or Browse to the new folder, or perform a = “weo=%d cenes
Search. R

Click the Choose button to confirm the appropriate folder and Lo ]
to close this window. .
You'll go back to the Move page screen where you’ll see New
Folder field populated with the new folder that you just

selected. -
+ Check Un-publish Content to remove the page from 7 monins ago
its original location on the live site as well as Cascade. UNWREL Dept Top-Nav-QA
IMPORTANT: If you do not check this box, a copy of webeommTest

the page will remain in its original location on the live
site with no way to edit it in the future.

Locate and click Move button.

You are then taken to the page preview screen. A message at the top of the asset will
confirming that the asset has been moved to the selected folder.

Asset successfully moved/renamed to UNIVREL-
Dept-Top-Nav-QA:program-overview/index

To move multiple folders or files at once:
* Click on the parent folder of the asset(s)
« Check the boxes of those you want to Move
« In the top box menu, select Move
« Specify the new location of the asset(s)

*NOTE: There is no way to un-publish files from their original location while moving
multiple files at once. Files should be un-published first by selecting Publish->Un-
publish.

**NOTE: If you're moving an asset that has been on the live site for a while, you might
consider planning a redirect from the old url to the new url. Contact web-

updates@mccormick.northwestern.edu if you need help with this step.
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Renaming Folders/Files
If you wish to update the Asset Name, you'd need to Rename it.

1. Find the asset in your navigation panel and click on it.
2. From the preview window, go to the More->Rename option.

[‘ Edit 6 Publish [:_' Comments @ Details **+ More

Move

Copy
Delete

Unpublish

3. Next, enter a new name for your asset in New Page Name field. For folder and
files, you will see New Folder Name and New File Name fields. Make sure that the
name you enter here is all lower case. Replace any spaces with dashes.

Rename page rre
UNIVREL-Dept-Top-Nav-QA: /title 92

1

New Page Name *

test-page)

Unpublish Content
Unpublish from Destinations

Previously published versions of the asset will remain on the webserver with the old path unless unpublished.
Unpublishing from the remote server will delete the out-of-date content from the chosen Destinations.

Qutput Publish

[EHT™L All Destinations

Destination

Q] Test Web Site

4. After you're done making your changes, save the page and publish it to the live
site. See Publishing or Un-publishing Your Assets section of this document for
further instructions.
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When we say rename an asset, we are talking about changing the Asset Name.
Renaming assets in Cascade will change the URL of the asset on the website. However,
we recommend never renaming an index page. Every folder should have an index page.

*NOTE: If you're renaming an asset that has been on the live site for a while, you might
consider planning a redirect from the old url to the new url. Contact web-
updates@mccormick.northwestern.edu if you need help with this step.
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Publishing Folders/Files

You can publish individual pages, multiple pages, and entire folders.
« Individual pages
« Click the Publish tab on the page.
» Choose which server to publish to (development or live or both)
« Request will be sent to the automated publisher
« Any images on the page will also be published, no need to publish them
separately
*  Multiple pages
+ Select the parent folder of the pages to be published
» Check the boxes of the pages to be published
« In the top box menu, choose Publish
« Cannot choose which server to publish to (must publish to all)
« Entire folders
« Select the folder to be published
 Click the Publish tab on the page.
« Choose which server to publish to (development or live or both)
You can also hover over assets in the left navigation panel and click the white down
arrow that appears and select “Publish” from the contextual menu.
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Deleting Folders/Files

« Click on the asset T ——
« Click the More option and the Delete option in the dropdown wore

Copy

menu.

CONTACTUS

Access

Q

hrch this site

« Check Un-publish Content while deleting to remove the page
from the live site as well as Cascade. IMPORTANT: If you do not
check this box the page will remain on the site with no way to edit

it in the future.
« Cascade also displays alerts for what pages/assets are linking to the file and will

need to be updated before deleting.

Delete page )
cance M”
UNNREL-Dept-Top-Nav-QA: /About/title - -

@ 1 asset(s) are still using this asset. Deleting it may cause broken links. More details

FAQs Test Top
Folder -
Reference

Tasks

Relationships

v Linking to this asset 1

Asset Last Mcdified Last Modified 3y

B Test Page moments 3go 2 shmb552

« Deleted files stay in Recycle Bin for 15 Days

You can also hover over assets in the left navigation panel and click the white down
arrow that appears and select “Delete” from the contextual menu.

Development Server
The McCormick site has a development environment which is essentially a copy of the

entire site accessible at http://mccormick-dev.tech.northwestern.edu. This location is

not indexed by Google and can only be accessed by sharing its url.

The development server can be useful for publishing pages for others to review who do
not have access to Cascade before making that page live. See more details on this in the
"Publishing Your Webpages" section of this guide.
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Module 5: Other Helpful Tips

Mark Content for Review

You can mark your assets for review if you want to update the information on a regular
basis or on a certain date. Assets that are marked for review will be listed you your
dashboard under Content to Review section. To do this, follow the steps below:

1. Go to the site and select the asset you want to mark for review.
2. In the preview window, locate and click on Edit. This opens a new window.

3. Inthe next window, switch to Metadata tab. Scroll down to enter a review date
and click Save and Preview button to save a draft. On the next screen, you'll
see the option to Submit. You don’t need to publish the asset after this step.

o © ] 45 — Save &
tent  Metadata re scree Preview

2 - Save and Preview

Teaser
Keywords
Description
Author

Start Date

mm-dd-yyyy hh:mm a

£nd Date

mm-dd-yyyy hh:mm a

Review Date

1 - Enter a review date

mm-dd-yyyy hh:mm a

Expiration Folder

Choose Folder
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Versions

Cascade retains the 90 most recent versions of an asset el o |o
To view previous versions, select an asset in the left Bl Rl
navigation panel, click the More tab and click Versions
You should be presented with a table of all previous versions.
«  When they were last modified and who modified
them.
Locate and click the version you would like to view. A
preview of the previous version is displayed in the main
Cascade window.

Versions for page
UNIVREL-Dept-Top-Nav-QA: /About/index

CONTACT & VISIT

s

Current Version

Last Modified
2 days ago by shm552
Comments

None

Past Versions

By - o §

Name Last Modified Comments

2 days ago

v3index

by o shms52

7 months ago L |

v2index Updated Title from Title' to "About".

by () dezs4ss

ayear ago Copied from '_internal/base_assets/Top
v1index F g

by m nsj448 Folder/index'.

If you want to view other versions, you can click on
More to see other viewing options. You can view an
older version, view a newer version, view current
version, delete the version or restore it. Notice that D) comments (O Details
the More dropdown doesn’t list any of the in-context
editing options like move/delete/publish. Restore this version

Delete this version

My Content Q, Search T +

You are view

If you wish to roll back to the version you are
viewing, click on Restore this version. Cascade
will create a copy of the old version and this will
become your newest version. You may edit this
version or just publish to the live site.

Compare with current
View current version
View newer version

View older version

Audits

Creating Line or Paragraph Breaks

In WYSIWYG editor
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« Enter creates a new paragraph
« Shift+Enter creates a line break
« If the text appears to be larger than normal make sure the block of text in
formatted for paragraph.
When writing a single line of text, hit Enter to ensure that text is in a paragraph

Basic Troubleshooting

Here are a few troubleshooting tips to try if you find a webpage isn’t loading correctly on
the web:

After checking that all the links and formatting are correct on your page in
Cascade, be sure you have published the page.

Try publishing the page a second time if:

the page isn’t displaying the same on your website as it appears in Cascade
the page isn’t loading correctly
there are broken links on the page

If the page still doesn’t load correctly after publishing, it might be a caching issue
related to your Internet browser:

Try to reload the page in your browser without cache by selecting Ctrl+F5 (for
Windows) or Cmd+Shift+R (for Mac).

If the page still doesn't load correctly, it may still be in the process of publishing. You
can check the publisher queue in Cascade to see if it that page (or other assets) is
still in the process of publishing.

To check the publishing queue in the content page:

* Select the Help menu on the top right of the
toolbar.

My Content Q, Search

Then select “Publish Queue”. There you can EE——
see what assets are in the process of publishing. (' Help &Support )
\ : _/'

If the page has been published and the problem still remains,
or the publisher appears to be stuck, you may contact

McCormick IT at web-updates@mccormick.northwestern.edu. IT may be able to
address the problem.

Publish Queue
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